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Windows 8: Don’t Hesitate – 

Let’s Navigate 
Greg Creech 
Enjoy using Windows 8.1 by modifying the Start screen, using the Charms bar, and 

employing helpful commands via the new Ribbon. We will explore Windows 8.1’s 

new tabs and groups in the Ribbon and learn productive shortcuts and tips and 

tricks, such as Snap and Jump Lists. Don’ Hesitate – Let’s Navigate and Learn 

Windows 8 together. 
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Oops!  and Legal  S tuff  

While I have made every effort to ensure the accuracy of this document, including grammar 

and instructions, I make mistakes. (Surprise!)  If you find an error or want to provide 

constructive feedback, please contact me.  Thank you!  Enjoy Windows 8 and this document 

as you discover how great Windows 8 can be. 

Greg Creech 

Techedutainment Services, Inc. 

P. O. Box 1431 

Pine Lake, GA  30072 

404-299-1706 

www.gregcreech.com 

A few items you should know about me: 

 International Association of Administrative Professionals Business Partner and Member 

 American Society of Training and Development Member 

 Society of Human Resources Management Member 

 Microsoft Office User Specialist Certification – Master Expert and Instructor 

 CompTIA Certified Technical Trainer + 

 A+ Certified Systems Technician through CompTIA 

 Microsoft Certified Technical Trainer 

 2007 Southern Region University Continuing Education Association Award Winner for 

the Top Non-Credit Programs 

 2009 Southern Region Association of Continuing Higher Education’s Faculty Award 

winner for my work at Emory University’s Center for Lifelong Learning  

 Former National Speakers Association Member 

Windows 8.1 ® is a most excellent Operating System product from Microsoft ® Corporation as 

are some of other products I mention such as programs of the Office® Suite, including Word, 

Excel, PowerPoint, Access, Outlook, and other fantastic programs. 

Copyright © 2015Greg Creech, Techedutainment Services, Inc.  All rights reserved.  This 

publication, or any part thereof, may not be reproduced or transmitted in any form or by any 

means, electronic or mechanical, including photocopying, recording, storage in an 

information retrieval system, or otherwise, without express written permission of Greg 

Creech, P. O. Box 1431, Pine Lake, GA  30072-1431, www.gregcreech.com. Special 

permissions given to IAAP and its members. 

  

http://www.gregcreech.com/
http://www.gregcreech.com/
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IAAP and Greg Creech  

On January 5, 1981, I entered the world of being an administrative professional as the only 

male Steno Clerk in Columbia, SC at Southern Bell. As my manager, Becky Davis, introduced 

me to all of the women, one funny woman exclaimed: “Well, there goes the steno pool; they 

let a rooster in the hen house!” Later in the day, I used an IBM Selectric typewriter to type a 

proposal. As I typed, I noticed the silence in the room and looked up to see everyone staring 

at me. The funny woman said: “I’ve never seen a man that could type like that. Who 

would’ve thought.” I could type 70 WPM with no mistakes. I worked in Sales and Marketing at 

AT&T in many clerical, administrative, and operations management positions. My longest 

responsibility for over 10 years was as a Compensation Manager in Sales and Marketing for 

various sales organizations , and in 1998, I took an early retirement buy out package as an 

Operations Manager. AT&T supported my comedy, musical, and motivational presentations 

internally and externally, too, so I had the best of both worlds: administrative position and 

entertaining presenter. I continue to enjoy at&t as a customer and supplier as I train on and 

develop Access databases for at&t. 

 

Since 1998, I have pursued my passion and love of technology, education, comedy/humor, 

music, and administration. In April 2006 for Administrative Professional Day, I presented my 

musical, humorous stress management speech at Midlands Technical College with over 650 

admins in my home town of Columbia, SC. Four months later, I and Mary Stuckey, my 

neighbor, were at a neighborhood meeting and she informed me that she was being installed 

as President – Georgia Division of IAAP. Mary and I have been neighbors for 9 years at that 

point and we never knew of our administrative connections. I told her about my presentations 

and programs. In November 2006 at an IAAP Educational Seminar in Macon, GA I presented my 

humorous, musical presentation on business communication, stress management, and career 

development entitled “SMILE”. I joined IAAP in 2007. The presentation was a hit and IAAP 

blesses me frequently allowing me to present at chapter meetings, conferences, and other 

events. Being included on this Louisville Summit conference is an absolute dream come true 

for me and I owe much thanks to my sisters in the Georgia and South Carolina chapters for all 

of the persistent and consistent recommendations, referrals, prayers, and compliments since 

the beginning. I hope you enjoy my presentation as much as I enjoy presenting it. 
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In t roduct ion –  Windows 8.1  

Microsoft® had a good idea of creating an Operating System that worked on all devices plus 

used the same interface and look. However, clients use smartphones, tablets, laptops, and 

desktops in different ways and are accustom to using various tools depending on the device. 

For example, I love my mouse and do not want to part from it in using my desktop. I find 

selecting items by tap and drag isn’t the easiest to select large amount of text on my tablet 

or phone, and I rarely created new and extensive documents, spreadsheets, or presentations 

on my hand help devices; I save extensive edits and document creation for my desktop and 

laptop, especially for inserting pictures, graphs, charts and other elements.  

When Windows 8 appeared with the login screen and the Start menu, folks immediately did 

not like the change. Using the desktop and the start button were more productive and less 

cumbersome on a desktop/laptop than a tablet or phone which we like the Start screen and 

tiles on these devices to navigate. The publicity and the client feedback prompted Microsoft 

to develop Windows 8.1 with the return of the Desktop at start-up and other needed 

improvements. We will cover the Start screen, revised Start button, touchscreen technology, 

and other improvements.  

I designed this course for current users of Windows XP, Vista, and Windows 7; this 

presentation and manual are not for the novice or those new to a computer.  I organized 

the information based on what most people would need to know first and then advance into 

more customization of Windows 8.1.  You should be at your computer and as you read the 

information make the changes.  Many of the options you set will not be edited again until you 

want to make a change.   

At a glance, here are some of the items that I enjoy using in Windows 8.1 (some of which 

Windows 7 introduced) and that we will learn in the course: 

 Customizing the Start screen for your favorite apps and tools, 

 Touch screen technology, 

 Charms Bar, 

 Working with the Ribbon and Quick Access Toolbar 

 Jump Lists in the Start screen and Taskbar, 

 Pinning Programs and Files to your Jump List, 

 Navigating between the desktop, applications, and the Start screen, 

 Search, 

 Snap – quickly rearrange your files side-by-side and maximize, 

 Peek – quickly viewing your desktop and activating the desktop, 

 And the List goes on and on! 

Get ready to experience how great Windows 8 can be.  
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The S tar t  Screen   

At first glance Windows 8 and Windows 8.1 introduce change to the familiar Desktop - the 

new Start screen which is an expanded version of the previous Start menu. Instead of the 

Desktop which contained the Start button to produce the Start menu as we have had for 

many years, now we have an entire screen devoted to our favorite applications, web sites,  

and system tools. Start Screen  effectively will reduce the need to load the Desktop with so 

many shortcuts so you can barely see your Desktop; however, as Microsoft has learned old 

habits die hard with folks like me who remember DOS. I like change as long as the change is 

productive; the original version of Windows 8 was not as productive as the past to navigate 

and to perform simple operations, like shutting down. Windows 8.1 reintroduces the Start 

button to toggle from the desktop to the Start screen, but right clicking or using your 

secondary mouse button to produce a terrific shortcut menu from the Start button is quite 

advantageous. We will learn about the renewed Start button and how to customize the Start 

screen to fit your needs with using the newest Microsoft Operating System. 
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The Windows Key ( ) on your keyboard activates the Start screen for you and toggles 

through your active file/program and your Start screen as you press the Windows key. You 

may click the Desktop tile or press the Windows key and the D key ( + D) to activate your 

Desktop screen.  The Windows key is on your keyboard but may look different than 

this  which is a legacy Windows logo; your Windows key may look more like this:  

Star t  screen –  T i les and Apps Views  

You may customize the Start screen in many ways to fit your needs. For example, when you 

right click or secondary click the Start screen, a menu at the bottom of your screen appears 

for you to customize your view. This is displayed below. In the customize view, you may type 

over the “Name group” item to create your own groups and add your apps to that group.  

If you are using a touch screen, you tap, hold, and release 

to retrieve shortcut menus. To select an App or tile you 

right click or tap and hold for a touchscreen, the tile or 

app and Windows selects the tile/app for you and 

provides a menu at the bottom of your screen to 

customize the tile. After renaming a group, you can click 

and drag your apps to that group.  As displayed above, I 

have created my Favorites group and my Office group 

with the appropriate apps. You may right click or 

secondary mouse click an app and the menu at the bottom offers important features for 
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customizing your app. For example, you may resize your app’s tile and you should pin your 

often used apps to your Start screen and your taskbar. Since I have already pinned Outlook 

2013 to my Start and to my taskbar, my screen displays Unpin as pictured here with Outlook 

2013 app’s menu.  This is an important menu to remember and use.  

 Hot Tip! Take the time to Pin your favorite and often used apps, tools, and 

other items to your Start screen and Taskbar which contain Jump Lists which we 

will learn about later.  Right clicking (secondary clicking) for touchscreen 

computers/tablets is Tap, Hold, and Release a screen, button, etc. and a shortcut 

menu or pane appears for you.  

When you choose the resize option, this menu appears for Small, Medium, Wide, and Large. 

After resizing you may click and drag the tile to a new location. Not all apps will have the 

same size selections; some apps may limit you to Small or Medium. Creating Groups is an 

efficient way of using your computer for other applications rather than only using your 

Desktop to navigate and open apps and files. Plus weather, photos, news feeds, and other 

apps are live and update for you. You may turn off a live tile by right clicking the tile and at 

the bottom choose “turn live tile off.”  

If you have a touch screen, you may swipe up to view all of your applications or you may click 

the arrow at the lower left of you Start screen to view all of your applications. 

The All Apps view is a terrific way to add Apps to your Start screen or to 

your taskbar or to navigate to rarely used apps and administrative tools.  

As described previously you may right click any app to use the customize 

menu at the bottom of your screen to add the app to your taskbar or start 

and perform other common actions. You may arrange your All Apps view 

by several ways when you click the arrow next to Apps you can arrange by 

name, date installed, by most used, and by category. Having the all Apps 

view is like having our old favorites of All Programs, Control Panel, and 

other items in one place.  

To the S tore for  App Shopping!  

On your Start screen is the Store tile; this is an important tile for you to add Apps 

to your computer. One noticeable absence from Windows 8.1 is no games! Not 

even, Solitaire. You’ll find other missing items, such as gadgets (the Windows Live 

Tile Apps replaces gadgets). So go shopping for many, many apps at the Store tile. 

When you sign in to your computer and Windows 8, you should use your Windows 

ID for consumers and other Windows ID for businesses as directed by your IT 

professional.   

 

Practice makes perfect: 
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Here are some exercises for you to accomplish: 

1. Rearrange your Start screen tiles by clicking and dragging them (for touchscreens tap, 

hold for a second, and then drag), 

2. Rename groups and drag apps to them, 

3. Resize your tiles as you like from the customize menu, 

4. Pin your favorite and often used apps to your task bar. 

 

The Wor ld of  Apps 

You will soon discover how the Apps in 

Windows 8.1 work and are filled with 

options for you to explore and use. You 

should start with Apps like the 

Weather, Photos, and Maps to 

customize the App to fit your needs. 

Remember to right click or secondary 

mouse click (or press and hold for a 

second on a touchscreen) once the 

App opens to see your options at the 

bottom of the screen. My weather App 

appears here with the options at the top 

and below the screen.  

 

The Photos App appears here and when 

I right click (or swipe down for 

touchscreens), a photo folder’s tile 

additional options appear below the 

gallery of folders. Once you open a 

photo folder you may edit the photo for 

cropping, rotating, color, and other 

options for your photo. While you may 

use other applications for your photos 

and other file types, you should try 

these apps. You go directly to the Start 

screen and the apps from your sign-

on/login screen. This saves time 

bypassing the Desktop.   
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These apps are not as robust as your similar desktop apps.  

Important  key combinat ions 

Toggling between your desktop, apps, and other areas of your computer can be cumbersome. 

Using the good, old ALT + Tab key provides the pane below with ALL of your open and active 

applications, system tools, desktop, and so on. As you press and hold the ALT key and then 

press and release (tap) the TAB key, Windows maneuvers through each pane for you to select 

the app or tool you wish to activate when you release the ALT key. 

 If you only want your Apps in view, press the Windows Key (  or ) and the TAB 

key and a you tap and release the Tab key, Windows moves through the Apps for you to 

select the App you wish to work with. If you are working with an App and press the 

Windows Key and the Tab key, the Desktop will appear in the list for you, so the active 

app or desktop item that you are working in will not appear in your list.  
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The Desktop 

From the Start screen, you may click or tap the Desktop tile to open your familiar 

Desktop screen. You may use the keyboard combination of your Windows key and 

the D key to activate your Desktop screen. The Microsoft Start tile button on 

your Desktop provides quick access to your favorite programs and files as never 

before with the Start screen.  The Start tile button appears at the lower left part 

of your screen where you should be accustomed from the 

previous start buttons in Windows. Your button changes color 

as you hover over it. You may toggle to the Start screen from 

your desktop or other App by pressing this tile button or 

pressing the Windows Key on your keyboard. However, the 

power of this button is not to toggle back and forth to the 

Start screen; the power is in right clicking or using your 

secondary mouse button to view the productive and new 

menu displayed here. The keyboard shortcut to activate this 

menu is the Windows key and the X key ( + X) or for 

touchscreen tap, hold, and release the Start button. 

 Hot Tip! The Secret Start Menu – Right clicking If 

you don’t remember or use any other item in this 

manual – this is one you should use early and often to 

save time and frustration in activating your File 

Explorer, Control Panel, to Shut down or sign- out and other shortcuts. Remember 

the Windows key and X or right click the Windows tile at the desktop.   

I find using this menu easier than using other areas of Windows 8.1, although the Charms bar 

contains efficient ways of accomplishing tasks. I have my Shut down or sign out cascading 

menus displayed here. This is one of the easiest ways to Restart, Sleep, Sign out, or Shut 

down your computer.  

There are websites that provide downloads that can give you the classic start menu with the 

directories, programs, and other items. 
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How Charming!?:  The Charms Bar  

The Charms Bar appears when you move your cursor to the right edge of your screen (or 

swipe from the right edge of a touchscreen) and move your focus to the grayed buttons 

(pictured at right) or use the Windows Key plus the C key, This is another quick way 

to navigate to often used tools. Once you move your focus into the grayed Charms 

area, the Charms bar activates (pictured at far right) as it blackens for you to select 

an administrative or system tool to use such as search, devices, or settings. You’ll find 

this easier than trying to navigate through the Control Panel. For example, when I 

click Settings, the menu offers PC Info which displays my version of Windows, the type 

of processor I’m using, and other geeky stuff.  This is a way to shut down by using the 

Power button on the Settings menu.  

The Charms Bar items change based upon where you active the bar. For example, 

if you activate your Charms bar while at the Start screen you receive a different 

Settings pane than the one pictured at right. 

 If you want to customize your Start screen follow these steps: 

1. At the Start screen, activate the Charms bar (Windows Key + C key) or 

move you cursor to the upper right of your screen, 

2. At the Charms bar click Settings and from Settings click Personalization.  

3. You may personalize the Tiles to display or not display the Administrative 

Tools on your Start screen. After pressing Personalize, Windows offers you 

a palette of choices for a back ground graphic and background color and 

accent.  

I’ll show you how to use your desktop background as your Start screen background 

later.  
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Desktop,  Taskbar  Shortcuts  and Jump Lis ts   

One of the important tasks to complete from the Start screen is to 

Pin your Apps to your Taskbar as we learned earlier. After pinning your 

Apps to the Taskbar, Windows magic begins tracking the files you 

open in the app to create a fantastic Windows 7 carryover feature 

entitled Jump Lists. We’ll look at customizing your Jump Lists and 

other important Windows 8.1 features as we customize your Taskbar, 

Navigation, and other items. 

Taskbar Properties 

At the Desktop, right click or tap and hold for a second on a 

touchscreen an empty area of your Taskbar to retrieve the menu at 

right. (Notice this allows you to rearrange your Desktop, Activate 

Toolbars, go to the Task Manager, and I have my Lock the taskbar 

selected, so my taskbar is always visible no matter the app or website 

I use. At this menu you should click the last item, Properties. 

The Taskbar and Navigation properties pane appears for you at the 

Taskbar tab. You should decide if you want to lock your taskbar so it 

is always visible or Auto-hide your taskbar so it minimizes when you 

move away from it. I’m over 55 years old, so the “Use small taskbar 

buttons” is useless for me, but if you have great eyesight then this is 

for you! You may change the Taskbar position or decide how you want 

Windows to group your apps in the Taskbar. We’ll look at customizing 

the Notification area later. We will learn about the advantages and 

disadvantages of the Peek feature, too. The important tab for us 

now is the Navigation tab which is new to Windows 8.1.  

Navigation Properties – Go Directly to Desktop 

One big complaint about Windows 8 was the inability to go directly 

to the desktop and use the Start menu. Windows 8.1 corrects this 

with the Navigation tab in the Taskbar and Navigation 

properties. While I like using the Start screen, I love my desktop. I 

use my desktop computer differently than my tablets and 

smartphones; I save files on hard drives (I know how old school) as 

well as on cloud services using my desktop computer. I create and 

edit extensive documents like this manual using my desktop or 

laptop, so going directly to  the Desktop is more productive for 

me (and many other Windows users, too). As displayed at right, 

the Navigation tab has important Corner navigation and Start 
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screen options for you to consider. I like using the Corner navigation except I do not use the 

Command Prompt and I like using the Windows key + X for my mini Start menu. If moving 

your mouse to the upper right corners to activate the Charms bar or having the Recent App 

screen with a click in the upper left corner annoys you this is how you may turn them off.  

The Start screen options allow me to select going 

directly to the Desktop after I login instead of Start 

and I can use the same desktop wallpaper on my Start 

screen so these are checked for me. I do like using my 

Windows logo key to toggle to my Start screen from 

my desktop or other application, so I have checked this 

option as well. You should decide how you want to use 

your computer – starting at the Start screen or 

Desktop and how you want the Apps to appear.  

Jump Lists Options 

The next tab in our Taskbar and Navigation properties 

dialogue box is Jump Lists. You may change the 

number of items (files, websites, folders) that you 

view in your Jump Lists. We will look at Jump Lists in 

a moment. I have set my items to 30; the maximum is 

60. Since I am the only user of my computer, I 

certainly want the Privacy items checked. These two 

items of storing your items in Jump Lists are the 

power and convenience of using Jump Lists. 

 

Toolbars 

The final tab in our Taskbar and Navigation properties dialogue 

box is Toolbars. As pictured at right I have activated my 

Links, Touch Keyboard, and Desktop toolbars. With Toolbars 

you add a cascading menu for you to choose the area you wish 

to Navigate. The Touch Keyboard button opens my onscreen 

keyboard when I want to use my touchscreen keyboard rather 

than my old fashion keyboard attachment. My Desktop 

toolbar’s menu appears below.  

Take the time to set these options once and only change them when needed 

which should be very rarely.  

 



  Windows 8: Don’t Hesitate – Let’s Navigate 
Greg Creech 

 

 

iaap-hq.org  16 
 

Jump Lists  

A productive feature from Windows 7 that carries over to Windows 8 is Jump Lists. We 

previously set the number of items in our Jump Lists, now time 

to use them. With your popular apps (including your favorite 

web browser, security, Adobe products, QuickBooks/Quicken, 

Microsoft Office, and so on) pinned to your taskbar, Windows 

tracks the files, websites, and folder from where you open the 

item. When you right click or use your secondary mouse button 

on an App in the Taskbar, a menu appears of your documents. I 

have my Word 2013 Jump List displayed at right. I set the 

number of items to view to 30. Notice the Pinned area.  One of 

the criticisms of using previous versions of Windows is knowing 

where your files are stored.  Throughout the new Operating 

System you my hover over a file and a screen tip appears 

alerting you to the location of the file.  I have my Windows 8 

manual file’s location displayed here as I hover over the file in 

my Taskbar. You don’t need to click or search to know where 

your file resides, simply hover your cursor over the file and 

there’s the screen tip . 

As you can see adding Apps to your Taskbar greatly increases 

your efficiency in using your favorite programs and files like 

never before.  The need to use Window’s File Explorer or opening the App first to open a 

folder, website, or file reduces with these new quick methods of Pining and using Jump Lists 

in Windows.   

 Hot Tip: You may rearrange your Taskbar apps by clicking and dragging (or tap and 

drag for touchscreens) them to where you want to move the app.   

Another terrific feature in Windows is when you have apps and files open, the Taskbar 

provides Thumbnails or Snapshots of the files for you to hover and see previews of your files 

or click and maneuver to the opened files 

and you may close the  files, too.  As 

displayed at right, when I hover over the 

Word button previews of my open files 

appear and when I hover over a snapshot, 

the close button and Screen Tip appear.  

As you move across the snapshots, previews 

of the files appear for you to click and give the file focus for you to work.  You don’t have to 

have a program pinned on the Taskbar for this to work.  Once you open a file, the 

application’s button appears on the Taskbar.  
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Preview/Show 

Desktop 

I don’t have Internet Explorer pinned, yet when I open 

multiple websites using Internet Explorer here are the 

snapshots I receive when my cursor hovers the Internet 

Explorer button.  I may click on any preview to open the 

website.   

As with pinned programs, you may right click on the button for 

a convenient short cut menu allowing you to pin your program and to view Frequent or 

Recent files.  My shortcut menu for Internet Explorer appears here at right. 

 

 

Peek at the Desktop  

I set my Peek 

feature earlier in 

the Taskbar and 

Navigation 

properties box 

and the Taskbar tab.; this options displays above. The Peek 

is a nice feature that as you are working in an application and 

want to view your desktop without leaving the application the 

Show Desktop/ Peek button which is located at the end of 

the taskbar and to the right of the time/date.  When you 

hover the end of your taskbar, which is my lower right corner of my screen next to date and 

time, my Desktop appears as a preview.   If you click this area, the Desktop activates for you 

to use the Desktop and if you click the area a third time you return to your application.   This 

is a quick way to maneuver from applications to the Desktop effortlessly.  In essence, you 

minimize all of your applications by clicking the Peek button once and then maximize them 

again with another click.  Since this may annoy some people, this feature may not be on by 

default for you in Windows 8.  

Important Notes:  

_________________________________________________________________________________

_________________________________________________________________________________

_________________________________________________________________________________

_______   
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The Windows 8 Ribbon  and Fi le  Explorer  

For those of us that have used Microsoft Office since 2007, we are accustom to 

the Ribbon which replaces the Menu Bar. Windows 8 has adopted the Ribbon 

interface rather than the Menu bar. Microsoft replaces the name Windows 

Explorer with the name File Explorer. When you click the File Explorer button 

on your Desktop, Windows 8 produces your Libraries, Documents or other view with 

the new Ribbon interface. 

With the Ribbon at the top of your screen you will see the Quick Access Toolbar another 

Microsoft Office feature. My Quick Access Toolbar displays at right. I have clicked the arrow 

at the end of the toolbar and from the cascading menu, I have added all of these commands 

by clicking them to produce the check mark. I am changing the location of my Quick Access 

Toolbar to be below the Ribbon making it easier for me to see and 

navigate to this toolbar. One of the reasons I like using my Quick Access 

Toolbar is that it doesn’t change as I click and work with the Tabs in 

the Ribbon.  

 Hot Tip! The Quick Access Toolbar – Gone is the standard 

toolbar and here is the Quick Access Toolbar. The Quick Access 

toolbar is always on your screen and has my favorite commands 

Rename, Delete, but my #1 favorite command is here: Undo!  
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Title Bar  

Tabs 

Groups contains 

Command Buttons. 

Quick Access 

Toolbar (moved 

below the Ribbon) 

Address Bar 

The Ribbon is below your Title bar at the top of your screen and contains Tabs, such as 

Home, Share, and View. The Tabs contain Groups, such as Clipboard, Organize, and New. 

Groups contain Command buttons. I have moved my Quick Access Toolbar below the 

Ribbon and below the Quick Access 

Toolbar is the Address Bar.  

Unlike the Menu Bar, when you clicked an item the cascading menu was vertical and text 

oriented, the Ribbon is horizontal and graphical. The Ribbon does take up more space on 

your screen, so you may minimize the Ribbon and use it has you did the Menu Bar. Here are 

the ways to minimize/restore the Ribbon: 

 Hot Tips! Ways to minimize and to scroll the Ribbon: 

 The new Minimize Ribbon arrow at the top of your window next to the 

Help button.  The Minimize the Ribbon button appears at right. With the 

Ribbon minimized the button becomes the Expand the Ribbon button.  

 To minimize the ribbon double click the active Tab’s Name, such as Home, 

View. Double clicking a tab expands/minimizes the ribbon, too. 

 Right click on any tab on the Ribbon and from the short cut menu choose 

Minimize the Ribbon at the bottom of the menu. 

 Keyboard shortcut of CTRL + F1 – when you press your CTRL (Control) and 

the F1 keys simultaneously on your keyboard Windows minimizes and 

expands your Ribbon, too.  

If you have a scroll wheel/button on your mouse and the Ribbon is NOT minimized, 

you may scroll through the different tabs rather than clicking the tab.  Moving 

your cursor or your focus to the Ribbon and rolling your scrolling button/wheel up 

or down changes the tabs for you! You must first have your cursor on a tab for this 

to work; otherwise, the application will scroll through your file – not the Ribbon.  
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Another item at the upper left corner of your Title Bar is the Control menu that activates 

when you click the button displayed at right. This menu provides quick 

access to Size, Minimize, Maximize, or Close. The Home, Share, and 

View tabs are standard throughout Windows 8 but other tabs may appear 

depending upon the item you are using, such as a Picture folder or the 

Control Panel. The Computer Ribbon appears below and only has the 

Computer Tab and View Tab. The Computer tab offers many quick ways 

to accomplish tasks, such as mapping a network drive or activating the 

Control panel.  

You will find using 

the Ribbon 

productive but 

getting accustom 

to all of the 

options and where 

they are will take 

some time.  

One consistent tab throughout the Ribbon is the File 

tab. The File tab offers Frequent places for you to 

pin your often used Folders and ability to open the 

application in a new window so you may view two 

folders side-by-side; this works if you want to look at 

the same folder in two separate panes and positioned 

however you like.  

Let’s overview each of the most common tabs in the 

Ribbon: Home, Share, and View. 

Home – It’s good to be home! 

The Home Tab offers many popular tasks and commands to use. The Home tab prevents us 

from having to use shortcut menus or open folder after folder until we get to the task we 

need to perform. Here are common commands that people use in Windows 8’s Ribbon. 
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Clipboard Group 

The Clipboard group contains good, old Copy, Cut, and Paste buttons for you to use. 

Copy Path – to copy the current location of your file or folder to paste in an email or other 

application – this displays exactly where Windows stores your file/folder. Here’s my path for 

this document’s folder after I use the Copy path button and paste it "C:\Users\Greg 

Creech\Documents\Windows 8". 

Organize Group 

Move to and Copy to – This menu allows you to Move (cut) or Copy (duplicate) selected 

files/folders to your often used folders. The last item in the menu is Choose location for you 

to browse where you want to move/copy the file/folders. 

Delete – This menu allows you to send your selected files/folders to the recycling bin or 

permanently delete them (OOPS!).  

Rename – Rename is just that has been around forever and allows you to change the name of 

your file/folder. 

New Group 

New Folder and New Item – These allow you to create a new, blank folder or using New 

item’s menu a different type of file based on an app, such as Excel, or Word.  

Easy access – Easy access provides ways of opening your file using Favorites, Pinning the 

Start menu, or including in a Library. 

Open Group 

Properties – The Properties button and menu opens the extensive Properties dialogue box 

which contains important information about the file/folder, such as file size, location, and 

making the selected item hidden or read-only. Several of these options are available in 

Ribbon without using this box. For example, we will use the View Tab to hide and unhide 

selected items.   

Open, Edit and History – Depending upon the type of folder or file you have selected these 

options and menus change. For example, if I have an Excel file selected, the Open menu 

allows me to open the file in spreadsheets applications, including Excel or Microsoft Works 

Spreadsheet. You can turn on File History if you like to keep backups of your important files 

to other locations.  
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Select Group 

Selections allow you to select ALL of your items in the current folder or window or to have 

nothing selected. Invert selection changes the view from those you have selected to 

unselected and vice versa. 

Share – It’s nice to share 

The Share Tab provides ways of sharing your selected items electronically, with other 

devices, or other people.  

Send Group 

This activates other 

programs to email, zip, 

print, fax, or burn the 

folders/files to a CD.  

Share with – This creates menus for you to share your information with computers, servers, 

or people on a network, homegroup, or other users that have access to your computer.  

I’ll leave the Advanced security button and dialogue box to your network and computer data 

geeks. 

View Tab 

Panes Group - Organizing your Window Panes 

While File Explorer may get busy with all of the panes available, you can turn them on and 

off using the Panes Group.  You may quickly turn on or off the Preview/Details Pane using 

the Preview or Details Pane button; the area at the right of your screen is the 

Details/Preview Pane area.  I have labeled the various panes and items for you below. Notice 

the two buttons in the lower right corner. These are quick view buttons to toggle between 

Details or Large thumbnails views. If you want to not have the preview or details pane 

appear, then click the active button and the pane closes – click your preview or details button 

again and it reappears.  
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Ribbon and Quick 

Access Toolbar 

Navigation 

Pane Details/Preview 

Pane 

Status Bar and Quick view buttons 

Main Window in 

Details View 

 

The Navigation Pane button in the View Tab offers you the ability to show or 

hide the Navigation Pane and other directories you want to view in your 

Navigation Pane. As you can tell, I tend to be a resource “pig” having all of my 

options selected.  I particularly like having my Favorites showing at the top of 

my Navigation Pane.  

 Hot Tip: You may click and drag a folder to your Favorites area, this 

creates a link to your folder. Clicking and dragging a folder to Favorites does 

not move or copy the folder but as your screen tip displays as you click and 

drag “Create link in Favorites”.  This is a quick and easy way to get to your 

often used folders. You may click and drag to rearrange your Favorites items, too.  
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Layout Group – Formerly known as Views 

The command buttons in the Layout group were different ways of viewing our information 

using the View item in the Menu bar, so they were referred to as Views. Now, since we have 

a View tab, the Layout Group contains ways of displaying our information in some neat and 

productive ways. Let’s start with my favorite layout/view – Details.  

It’s is all in the details – Details Layout   

 

Here are some of my favorite reasons for using the Details Layout: 

 The Details views as displayed in the above photo allows you to quickly 

sort your folders and files by clicking the column header, such as Name, 

Date modified, and Type.  You can click to sort Ascend your information 

or click the heading again to sort your information in descending order. 

 You may rearrange the columns by clicking and dragging the column 

header to the right or left to reposition your column. 

 You can right click on a column header and add or remove columns, such 

as Tag, Author, and so on.  I will add the Date Created column to my 

details view through the short cut menu.  If you click the More. . .  item, 

you will receive MANY more properties or columns to display – there is no 

shortage here.  

 You may position your cursor between two columns at the vertical stripe 

separator and when the double headed arrow appears, double click to 

auto fit the column for you or you may click and drag the double headed 

arrow in or out to widen or lessen your column width.  Using the column 

header’s short cut menu you may Fit your current column or All columns as displayed 

at the top of the menu here. 
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 Finally, you may filter easily and quickly in the details view.  

As displayed here, I have clicked the column header filter drop 

down for Name to filter on certain numbers or group of letters 

for the folder/file name and I have clicked the Date’s arrow too 

to illustrate the many ways of filtering your 

information based on relative dates. When 

you click the box for “Select a date or date 

range”, you may use the Calendar to choose 

the date or if you click the Calendar’s  

heading you may choose the month, if you 

click the calendar heading again you may 

choose the year.  This is a very helpful and 

easy tool to view your items by many different dates and date ranges. The Type 

column heading is great to restrict the type of files you wish to view.   

None of the other views is going to offer this much power and efficiency in organizing and 

viewing your information.  So, I will use the All Powerful Details view to organize my data and 

then I’ll switch my layout to Tiles, List, etc. for displaying the filtered and sorted files and 

folders. 

Icon Layouts 

For photos and graphic folders I use the Extra large or Large icons (thumbnails) view, since 

I’m over 55, the Small and Medium icon views don’t do me much good.  

List, Tiles and Content Layouts 

These are good for files and folders that are not graphical and are easier to view your 

information than Details. List compacts your information very nicely and Tiles takes less 

space as well. Content provides a thumbnail of your files/folders with basic information 

about the folder and file with much white space so the screen is 

not so “busy”.  

 

Current View 

Sort by 

When you are not using the Details view, you can Sort by using 

the Current View and the Sort by menu. This displays the 

columns or ways of viewing your information by Date, Type, 

Size, etc. The Ascending and Descending options are in the 

menu for you, too. 
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Group by 

This works like the filter in our Details View and limits the items you view by Alphabet, 

Dates, and other areas. The option of None in the Group by menu is helpful when you have 

Grouped your items and want to return to a normal view.  

Only the Details layout uses the Add Columns and Size all columns to fit buttons and menus 

in the Current View Group. 

Show/Hide Group 

This group is great for viewing or hiding your selected files/folders plus I like knowing my file 

extensions, especially in using various Office versions and photo apps.  The Hot Tip below 

shows my file extensions and that I’m using check marks to select my files/folders and other 

items.  

 Hot Tip! New way to select files. There is another new feature introduced in 

Vista that I really like in selecting my files and folders and that is having a small 

check box appear for me to use in selecting 

one or many files/folders. This is particularly 

helpful when selecting items that are not 

continuous. In the past we used the CTRL 

(Control) Key and then clicked files that were 

not continuous in order to select them; this 

CTRL + Click method still works great for you. 

While the files and folders continue to 

highlight with your selection having a check 

mark to ensure my selection doesn’t hurt me either. I recommend giving this a try 

if this is not on by default. I have a sample of the check marks displaying that have 

three files selecting and ready for moving, duplicating, opening, and so on and on.  

You should try the Item check boxes option in the Show/hide group of the View 

tab as displayed here in selecting your files and remember your CTRL + Click 

keyboard shortcut.  

Options and More Options 

The only option you have is to activate your Folder Options Dialogue box and tabs through 

the Options menu item Change folder and search options. Listed below are the tabs in the 

Folder Options Dialogue box with explanations of important items, some of which are 

available on the Ribbon that we have learned.  
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Folder Options – Generic items 

The Folder Options dialogue box opens at the General Tab.  

From here you may determine if you want folders in separate 

windows or replace your existing window.  After all of these 

years, I still have not grown accustomed to Single clicking to 

open files, programs or folders, although I am comfortable in 

single clicking for hyperlinks, etc.  Since very old habits die 

hard, I keep my Double click to open an item selected. You 

may prefer the new generation of Single clicking. The 

Navigation pane section offers you the ability view favorites, 

all folders, and libraries in the Navigation Pane and to 

automatically expand your current folder. In previous versions 

of Windows the plus(+) symbol was used for expand and the 

minus (-) symbol was used for collapse. Windows now uses 

arrow to help with expand and collapse. Clicking the arrow to 

the right of the folder expands the contents or collapses the 

contents of the folder. You will see these collapse and 

expand arrows throughout the new operating system. You 

should set your General options here and click Apply.  Apply will make your changes and if 

you don’t like them you can change the option back before closing the dialogue box.   
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Folder Options – A View from the Top 

There are many new options from which to choose in 

Windows – this should be at the top of your option list to 

review as you convert to Windows 8.1. Some of these options 

appear in the Ribbon and the View tab as we previously 

discussed, such as Show hidden items and using Check boxes 

to select items. These are important items to know, to use, 

and to abuse.  Particularly important is the Apply to Folders 

button, you can set ALL of your folders with the current view 

of the open and active folder in which you are working.  As 

you know I like using the Details view, so that is my default 

view for my folders.  Clicking Reset returns your folder views 

to the factory standards. In the Advanced settings area, 

there are some items I recommend changing. First, I like 

viewing all of my drives so I have unchecked the Hide empty 

drives item. Another important option is the file extensions, 

I like knowing my Office 97-2003 documents separate from 

my Office 2007/2010 files and other files types of which 

I’m not aware. Just because Windows knows the 

extensions for files doesn’t mean I know all of the file 

types. By deselecting this helps me know the type of 

file as does the icon representing the application; 

however, the icons don’t help someone, like me, with 

poor eye-sight and over the age of 50. When you see 

your files the extension will appear with the file name, 

i.e. Office 2010.docx or Budget.xlsx; otherwise the 

system would display Office 2010 and Budget. This 

option is in the View tab of our Windows Ribbon, too. 

Folder Options – The Search is on 

Search offers technical information about searching that I 

leave alone, especially the indexing feature which helps 

the terrific speed at which Windows will locate your search 

criteria. We will look at the new Search Tab in the Ribbon 

next. 

After making all of your selections, you may click Apply or 

Click OK. Clicking OK applies your items and closes the 

dialogue box.   
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Key Tips 

While I have concentrated on using the mouse and touchscreen, there are 

new ways to use your keyboard for shortcuts. We have used the keyboard 

combination of CTRL + a key, such as CTRL + A to select all. In Office 2007, 

Microsoft Office introduced Key Tips which appear when you press the F10 

key or the ALT key on your keyboard. As displayed at right, after I press my 

F10 or ALT key the labels for my tabs and Quick Access Toolbar appear. If I 

press H for the Home Tab, the 

tab activates with Key Tips for 

the Home Tab’s command 

buttons. As pictured here I can 

press D to activate the Delete 

menu or press SA to select all 

of my items in the pane below. 

Using Key Tips alleviates the need to use the mouse or touchscreen to use your favorite 

commands and tabs.  So if you are a keyboard fanatic, you’ll love using key tips and not touch 

a screen or mouse to perform your actions in using th Ribbon.  
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Search -  Seek and you wil l  f ind  

At last!  A Search system that actually works and is fast (I promise).  With Windows 7, 

Microsoft made terrific improvements with searching and the features are even better in 

Windows 8.  

We will first search using the File Explorer and then we will search using the Charms Bar or 

Start button’s short cut menu. 

File Explorer Search – 

 

The Search box circled above is at the top, right corner of your File Explorer pane. You may 

change the width of the Search box and Address bar by positioning your cursor between the 

Address bar and the Search box and a double headed arrow appears allowing you to click 

and drag to widen or shrink the boxes.  

The Groups and Command buttons are briefly described here. 

Location – The buttons in this group allow you to determine where Windows will search for 

your files/folders based on Name, Date, Size, Type of File and so on. 

Refine – The Refine Group contains important buttons and menus for you to establish the 

criteria you want for your name search. The Date modified offers dates such as Last Week, 

This Week, etc. The Kind and Size buttons and associated menu options allow you to find 

certain types of files/folders and the size of the files/folders.  

Options – The Options Group has some of the 

same items as we saw in our Folder Options 

dialogue box and Search Tab. I use Recent 

searches and Save search quite often. When I 

complete my search, I click Close search. 

At right, I am searching in my Documents 

folder/directory for Window 8.1 as a Document file 
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and Modified this year. You can open the file or folder from this pane by double clicking the 

file/folder. 

Windows Search  

One of the important items that we covered earlier was right clicking the 

Start tile/button on your desktop and from the shortcut menu navigate to 

powerful and productive tools in Windows. This mini Start menu contains 

Search as pictured at right. Also, we learned about the Charms Bar and 

Search is the first item in the Charms bar with the magnifying glass.  

After activating search, the Search Pane appears for you to decide where you 

want your search by using the cascading menu arrow next to Everywhere. I’m changing 

mine to files to search for Windows 8.1. After typing the name I want to search, I 

press enter and a File Results pane appears for my search text, in this case Windows 

8.1. These files are ones that use often the other 84 documents 

are some that Windows created as RTF files. As you start typing 

Windows will provide the files (or other items) below your Search 

box.  

 

Here is my search results pane as I enter Windows in the Search 

box and Search Everywhere. 
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Manage and Play Tabs 

As with many areas of using Windows, there are too many options and now too many tabs! 

Depending on the type of item you are using or viewing in the File Explorer panes, you may 

see a Manage tab that appears for you to use some neat and powerful tools. I have displayed 

here the Picture Tools Manage Tab and Drive Tools Manage Tab. With these Tabs you can 

perform basic tools for your photos and your disk drives. With the managing your photos you 

can rotate your selected photos, see them as a Slide Show or set as a background for your 

computer. 

The Drive tools are good to perform system maintenance for Optimzing and Cleaningup your 

computer drives. STAY AWAY FROM FORMAT! You should not format your hard drive and be 

careful of using this tool unless you are an experienced technology professional. The Media 

Group is great for CD/DVDs and drives of this type. 

 

Music and Video have the Music/Video Tools with the Play Tab for you to play your audio 

and video files. 
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Librar ies  

Just like the old brick and mortar libraries, Windows 8 Libraries are a collection of 

documents that are stored in a neat 

fashion regardless of where the 

folder resides.  By default, Windows  

contains four Libraries: Documents, 

Pictures, Music, and Videos.  Like 

categorizing books and written 

documents in an analog library, 

Windows categorizes documents by 

file type in the digital library. The 

extensions and file type determines 

where Windows stores the folder and 

files for the Library.  The 

improvement of using Libraries 

versus the old fashion My 

Documents, Video, Music, and other 

folders is Libraries display the 

folder regardless of location, 

such as on a server, another 

computer, Public Folder and so 

on. You can create your own 

Library by right clicking on the 

Library icon in File Explorer 

for a Shortcut menu.  From the 

Shortcut Menu you may trace to 

New and from the fly out menu 

click Library.  As displayed at right, I am creating my own library named 

Greg.  When Windows creates your Library, you may open your empty 

library and click the Include a folder to add folders to your Library.   

When you right click on your Library and click Properties, the Library 

Properties features the Add  . . . for you to include a folder from your 

Network, other computers, servers, and so on.  While you may Optimize 

the library for specific items, such as Music, Pictures, Documents, and 

Videos; I have kept my General Items and I have added My Videos and My 

Documents folders to the Library and these folders do not need to reside 

on my hard drive for my Library to collect them.  

You should visit the Windows File Libraries early and often and create 

your own Library.  



  Windows 8: Don’t Hesitate – Let’s Navigate 
Greg Creech 

 

 

iaap-hq.org  34 
 

Navigation in F i le  Explorer  

Using the enhanced Address bar introduced in Vista took some getting use to for me. Using 

the Up One Level button became habit forming for me and is 

back in Windows 8. However, once I learned the new ways of 

navigating using the Address bar, I have formed new habits of 

moving around in my Desktop, Libraries, Files, Folders, etc. 

You may certainly use the Navigation Pane to move around but 

you may want to not show the pane in your Layout Options.  

You can navigate using the Address bar as displayed here.  You 

may click on an arrow to select the Folder/File you wish to 

activate.  As displayed above, I can quickly navigate to my 

folders under the Documents directory/folder through the drop 

down list.  By clicking the arrow associated with those 

directories, I can quickly go to my other Libraries, Desktop, or 

Documents. Once you click to activate a drop down list, you 

view the other directories/folder list by 

hovering your cursor over them, too; no 

need to click after you have clicked 

once.  As I hover my cursor over the top 

level folder (circled at right) my 

Desktop, Libraries, Network, Control 

Panel, etc. displays for me to navigate 

to those items. 

If you are old fashioned and like me, old enough to remember the drive/directory structure 

(path) as displayed here, you may type your folder/file location or use this path in other 

documents. Clicking in the Address box or 

pressing the ALT + D key displays the 

traditional folder/file path structure with a 

colon and slashes.  

Next to the Address bar are some very helpful buttons for navigating back, 

forward, to recent places, and up through your drives, directories, and 

folders. The Up One Level arrow button back tracks through your location 

and takes you up your parent folders and drives.  You may use the first 

button the back button to return to your previous locations. The Recent places arrow traces 

your history for your current session of using File Explorer and provides a list of locations you 

have been (duh?). The Back and Forward buttons with the Recent places button make 

navigating in Windows a breeze. 

Have refreshing experience! The Refresh button is at the end of the Address bar. Files and 

Folders may change while you are using File Explorer pressing this button ensures you have 
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the latest information. The F5 key is the keyboard shortcut for refresh while using File 

Explorer.  

 

 Hot Tip – Keyboard Shortcut for Moving Up your folders:  You may use the keyboard 

shortcut of pressing the Alt key and the Up arrow key together to move up your 

folders/directories. Unfortunately, the Alt and Down arrow keys will not move down your 

list. You may use your Back and Forward buttons, too, to navigate through your actions 

and directories/folders.  

Another very old habit is having two panes (or more) of the File Explorer open for me to 

move or copy folders and files (Remember File Manager in Windows 3.1!?). Once you have 

File Explorer open in one pane, you may activate another pane through the File Menu and 

click Open in New Window and choose Open in New Window again. Having two panes to 

move and copy files for me is easier than trying to accomplish this using the Navigation and 

Contents pane in one File Explorer pane. Also, I may need to compare the contents of 

separate drives/folders on one screen in two panes.  

Now, we will learn a new feature that will help with having the two panes open and having 

them side-by-side using the Windows 7 Snap feature which carries over to Windows 8. Then 

we will familiarize ourselves with selecting files and folders in a variety of ways. 

I t ’s  a Snap !  

A new Windows 7 Snap feature carries over to Windows 

8 and allows you to position your panes side-by-side, 

vertically, or maximize your screen.  When you click on 

a title bar of an application you may move the pane to 

the side of your screen (left or right) and the pane will 

“snap” into place.  Then you may click on another 

application’s title bar and click and drag it to the 

opposite edge of your screen and it will “snap” into 

place.  This reduces the need to resize your panes and 

click and drag a lot to get the Window panes side-by-

side. Notice as I click on this document’s title bar and 

drag it to the left of my desktop an outline appears in 

the background – this is illustrating that my document 

is ready to snap into place when I release my mouse 

button. 



  Windows 8: Don’t Hesitate – Let’s Navigate 
Greg Creech 

 

 

iaap-hq.org  36 
 

 Hot Tip – Snap to it – Keyboard Shortcuts:  You can use keyboard shortcuts to restore 

and to snap to the right and left, too.  Pressing the Windows logo key  and your left 

arrow key snaps your window pane to the left of you desktop and Pressing the Windows 

logo key  and your right arrow key snaps your window pane to the right of your 

desktop.  As you press your Windows Key and use the Right or Left arrow keys on your 

active pane, the pane toggles from right, to restore, to left. Now, you are ready to 

compare your documents, files or to perform other actions, such as copying files and 

folders. You may use the Windows key and the Up arrow to maximize your screen, too, 

and the Windows Key and the Down arrow key to restore your screen. If you continue to 

press the Windows Key and the Down arrow, Windows will minimize the pane.  

Next, I click on another Title bar of a file and drag it to the right of my screen and when the 

outline appears I release my mouse button and now I have my two panes side by side for me 

to compare, move, copy, view, and so on with the two files.  

If you click on a Title bar and drag the program, file, etc. to the top of your screen the pane 

automatically Maximizes for you.  You may use the old fashion way of double clicking a Title 

bar to maximize and to resize for you, too. Or you can still use the Maximize/Restore 

buttons at the top right on your Title bar next to your close button.  I have found snap easy to 

use once I figured out what in the world was going on when I clicked on a title bar to move it.   

You can vertically snap, too.  We have become accustomed to reading our information 

vertically without changing the width – particularly for web sites.  You can vertically snap by 

moving your cursor to the top or bottom border of your pane and with the double headed 

arrow click and drag to the top or bottom of your desktop and the pane will snap to the entire 

length of your monitor without changing the width.  

 Not all programs and applications have this ability, especially some of the legacy 

programs and applications.  So, if you try to snap and 

the application/pane won’t snap – it isn’t you – it’s the 

application.   

How to turn the darn thing off! If this annoys you, you 

can go to the Ease of Access Center in the Control 

panel and the Make the mouse easier to use section. 

Select the Prevent windows from being automatically 

arranged when moved to the edge of the screen (this is 

snap) in the Make it easier to manage windows section.  I 

have circled the item here for you; this feature is on by 

the default. But, try it first, you might like it once you 

learn how to control snap and lean how to view the 

outline associated with snap. 
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Shake I t ,  Baby,  Shake I t  and  

Arranging your Desktop i tems!  

For old timers like me you may remember the old rock and roll song, “Shake, Rattle, and 

Roll”, well, Windows 7 and 8 has Shake, Snap, and Snip! We just learned to Snap, now we 

will learn to Shake, and later we will Snip.  This is another item that if you are not aware of 

Shake and accidentally Shake; you’ll wonder what Windows did with your files.  Shake allows 

you to minimize all of your open files at once, EXCEPT the active file in which you are 

working.  This is tricky if you are not good with a mouse, so here’s a Hot Tip for you. 

 Hot Tip – Shake it – Keyboard Shortcuts:  You can use keyboard shortcuts to Minimize 

and restore all of your open and active panes, too, EXCEPT the open and active window in 

which you are working.  Pressing the Windows logo key  and the Home key minimizes 

all of your open and active files (that are not already minimized).  To restore the files 

back to your Desktop – press the  Windows logo key  and the Home key again and your 

files are back as they were.  

You may use the good old shortcut of right clicking your Taskbar and from the 

Shortcut menu Cascade, Stack, or Show your windows Side by side.  After 

choosing Cascade or another display, you may use your Shake feature (click and 

drag the Title bar back and forth rapidly) by clicking a Title bar and shaking it 

to minimize all of the other files.  To restore the files back to the display you 

can click the Title Bar of your active file and quickly shake (click and drag the 

Title bar back and forth rapidly) the files restore for you.  If you are “mouse 

challenged, you may use the keyboard shortcuts described above. I am not adept at using this 

feature, but I have accidentally “shaken” the title bar and wondered what happened to my 

files. 

 Hot Tip – Minimize ALL windows – Keyboard Shortcuts:  You can use keyboard 

shortcuts to Minimize all of your window and restore all of your open and active panes, 

too.  Pressing the Windows logo key  and the M key minimizes all of your open and 

active files (that are not minimized).  To restore the files back to your Desktop – press the  

Windows logo key , the SHIFT key, and the M key again and your files are back as they 

were.  

  



  Windows 8: Don’t Hesitate – Let’s Navigate 
Greg Creech 

 

 

iaap-hq.org  38 
 

 

I have my windows in a Cascade view here, I can 

“shake” the title bar of one these files and the 

others minimize. I can click and shake the title bar 

again and the files restore just as they appear 

here. I can use my keyboard shortcuts, too. 

Select ing f i les,  fo lders,  

and i tems 

New with Windows is the ability to select your files, folders, and items using check marks 

which we have previewed earlier. Having an additional way, other than highlighting a file, to 

know that you have an item selected is always helpful for me.  This gives an extra indication 

that you have items select, especially if I’m deleting information.  In a previous section on 

folder options, I outlined how to activate or deactivate this feature. This may be on by 

default for you. The many ways of selecting files/folders are still around. 

Here are the primary ways of selecting files/folders, etc. to prepare for moving, copying, 

opening, and performing other actions: 

 Click one file to select it and press the shift button then click another file to select 

the files contiguously, 

 Click one file to select it and press the CTRL button and with the CTRL button pressed 

click other files to select them in a contiguous and non-contiguous manner, 

 Click in an empty area of File Explorer and as you Click and Drag Windows produces a 

rectangle whatever that rectangle 

touches selects for you. 

This method is displayed at right. I click at the 

lower right area of my pane and as I click and 

drag up and over to the left the files select for 

me.  Notice that highlighting difference – the 

darker blue is my selection rectangle and the 

lighter highliting with the check marks are the 

files I have selected. After selection of these 

contiguous files, I can use the CTRL key and 

click to deselect the files I no longer want 

selected. See how the check mark helps in knowing your files, folders, etc. are selected. 

 Hot Tip! Using Check Marks.  You may select files, folders, drives, and so on and on 

using Check Marks.  Check Marks appear for you when you hover over an item so they are 
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not distracting in your views.  You may use the check mark by clicking the box to select 

files and the check apears. This is terrific for selecting your files and folders individually, 

contiguously, or in a range.  

Good old Copy/Cut and Paste are still around and here are the ways you can copy and paste 

in File Explorer: 

 Use the keyboard shortcuts of CTRL+X for Cut, CTRL+C for Copy, and CTRL+V for 

Paste. 

 Use the Home Tab in the Ribbon and the Cut, Copy, or Paste command buttons. 

 Use your Right Click shortcut menu on selected items. Right click the file retrieving 

the shortcut menu then click Copy/Cut, then navigate to where you want to copy/moe 

the files and right click and click Paste. 

 Click and drag to move files/folders in the same drive. If you click and drag 

files/folders to other drives, such as a flash drive, CD/DVD drive, or server, the items 

are copied. If you want to copy the selected items in the same drive but a different 

folder, you press the CTRL key as you click and drag to the receiving folder, after 

releasing your mouse button the items copy to the destination folder. 

Practice makes Perfect – Here’s some suggest exercises to help you learn. 

1. Open several files and practice snapping two files vertically side by side. For example, 

using Outlook snap your calendar on one side of the screen and then snap an Outlook 

email on the other side of the screen.  Compare two Word documents side-by-side 

using Snap. Open File Explorer and My Computer and Snap them Side-by-Side and 

notice how you may view different drives and folders. Practice copying files from one 

folder to another. 

2. Use different methods of selecting your files and folders. 

3. Use different methods of copying your files and folders to other drives and devices to 

create a backup. 

4. Snap a file for maximizations by dragging the title bar to the top of your screen and 

double click a title bar to restore the file. 

5. Have a pane in a restore state and using the vertical snap – click and drag the bottom 

border of the pane until it snaps vertically the length of your screen. 

6. With multiple files open use your shortcut menu on your Taskbar by right clicking an 

empty area of the Taskbar and from the menu choose Cascade.  

7. With your windows in a Cascade view, click the title bar of one of the files and shake 

it – the other files minimize for you. 

8. With your files minimized, except for your current and active file, press the Windows 

Logo Key  and the Home key to restore your files in the Cascade view. 

9. Practice, Practice, Practice – Shake, Snap, and Whip your Desktop Items into Shape! 
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The Windows Salute !  

As we have learned, I have pressed the Alt and Tab keys simultaneously to toggle through my 

Desktop, Open Files, and Programs since 1991 with Window 3.1. Also, I have used the 

Windows Three Fingered Salute (CTRL and Alt and Delete keys pressed together) to 

activate the Task Manager for many years.  Thankfully these are still 

available. The differences are the appearance and growth of the 

computer (Task Manager).   

Task Manager (Windows Three Fingered Salute) 

While my need to use the CTRL + Alt + Del keys have lessened, I still 

need to use these keys to activate my Task Manager when an unruly 

program or stubborn Printer  is unresponsive (Imagine!).  The CTRL + 

Alt + Delete keys activates a menu for you to choose the Task 

Manager, Lock, Sign out, or Switch User.  I usually activate my task 

manager as displayed here.  At times the Status may be unresponsive 

or the status may say running by the program isn’t running.  I select 

the errant program/file and click the End Task button.  The more 

details arrow button provides more tabs and 

functionality as displayed at right. While I use the other 

tabs such as Startup and Performance, I generally use 

the main Task Manager window and the End Task 

button.  

    Hot Tip! You can activate the Task Manager 

directly bypassing the menu with the CTRL + SHIFT + 

ESC keys. Another neat three fingered Windows 

Salute!  But, using the CTRL + ALT + DEL keys helps 

for Signing Off and Switching Users quickly.  

  



  Windows 8: Don’t Hesitate – Let’s Navigate 
Greg Creech 

 

 

iaap-hq.org  41 
 

Notification Area – Formerly known as System Tray 

Alas, beginning with Windows 7, the Notification Area replaces the old System Tray.  The 

System Tray did not allow customizing as the Notification Area does.  Windows 8 allows you 

to enable notifications, icons, and other actions to suit your needs.  The 

Notification Area displays where the former System Tray resided – 

next to the Time/Date.  The Notification Area contains Systems icons, 

such as the Action Center, Network Center, Power Plan, Master 

Volume and may contain others depending upon your computer.  When 

you click the arrow in the Notification Area, all of your hidden icons 

appear.   Clicking the Customize link displays the Notification Area 

Icons pane for you to select the items you want to appear.  You may 

use the Taskbar properties pane to activate the Notification Area 

Icons, too.  

Using the Notification Area Icons pane, 

allows selecting the buttons you want and 

have them display when you want.  If you 

select Show icon and notifications, the 

icon appears in your Navigation Pane as it 

did in the System Tray.  If you select Hide 

icon and notifications, the icon will 

appear in your menu when you click the 

Notification arrow. If you choose only 

notifications, you will receive a balloon 

alert without the icon. If you enable the 

“Always show all icons and notifications 

on the taskbar” ALL of your items display 

as in the old System Tray – this will 

probably crowd your taskbar unless you 

change your settings to Only show 

notifications.  The Notification Area Icons 

pane allows you to activate the System 

icon pane to turn these important items on 

or off and you may return the Notification 

Area back to the factory standard by 

clicking the “Restore default icon 

behaviors”.  

As you add programs, devices, and tools to your computer your Notification Area may 

incorporate needed icons that the device or program uses for updates, alerts, and other 

items. 
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 Hot Tip! When you use a Flash/USB/Thumb Drive 

(whatever you prefer to call this little miracle drive) or 

other external drive device, you should use this 

Notification area to Eject the Flash/USB drive safely.  When 

I press the Notification Area’s arrow and receive the menu 

at right, I may click the USB/Flash drive button (the last 

one in my menu and circled for you) and the screen tip 

appears.  Click this will allow you to choose to eject the 

device safely or will alert you that the device is in use. I 

encourage you to practice safe computing by ejecting the drive correctly rather than 

yanking the drive from the USB port which we are tempted to do, but doing so may 

corrupt the drive and/or files/folders. Better safe, than sorry.   

Important Notes:  

______________________________________________________________________________

______________________________________________________________________________

______________________________________________________________________________

______________________________________________________________________________

______________________________________________________________________________

______________________   
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Desktop Customizat ion  

With the advent of Window 3.1 we learned how to use Screen Savers, Wallpaper, and Color 

Schemes.  As we migrate through the different versions of the Windows’ Operating Systems, 

we want to customize our Desktop with the latest and greatest Themes, 

Screen Savers, Wallpaper, and other settings to make our computing 

experience more enjoyable and personable. Starting with Windows 7, 

Windows has some terrific new color themes, Screen Savers, Wallpaper, 

and ways of customizing these features for your tastes.  As in many areas 

of Windows, the Control Panel handles Desktop customization for us; 

however, as in other areas of the Control Panel you do not have to use 

the Control Panel to get to the panes that will help you.  When you right 

click on an empty area of your desktop or tap and hold on a touchscreen, 

a shortcut menu appears for you as displayed at right. You may change 

your Screen Resolution and Personalize your desktop settings.  We will 

look at these items and the View and Sort by options on this menu 

in this section.  

The Desktop shortcut menu also provides ways of quickly creating 

New items, such as folders, Microsoft Office documents, and 

contacts.  The New item in the short cut menu has the Shortcut 

feature, which opens another pane for you to type the location of 

the file/folder or browse to the file/folder for which you want to 

create a shortcut. 

Desktop Shortcuts 

As described in the previous paragraph, one of the most popular 

ways of customizing the Windows’ Desktop is using icons for 

shortcuts to activate programs, files, and folders.  In fact, this is so popular for some folks 

that you can’t see the Desktop’s background for ALL of the shortcuts that display on their 

screen! I admit I’m guilty of this; however, since Windows 8 has the Start Screen and the 

Desktop Taskbar to pin files and programs and to use the Jump Lists, my Desktop screen is 

far less busy than in previous versions of Windows.  While the Start screen lessens my need 

to create multiple desktop shortcuts in Windows 8, I still enjoy the convenience of Desktop 

Shortcuts. Here’s a couple of ways of creating shortcuts to your favorite program, files, and 

folders. 
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One of the most popular ways of creating a Desktop 

shortcut is to right click on a file, folder, or program in 

File Explorer and from the shortcut menu trace to Send to 

and from the fly out menu choose Desktop (create 

shortcut). As displayed at right, I right clicked on my 

Windows 8 folder and from the shortcut menu traced to 

Send to and the fly out menu displays options that I may 

send this folder to other areas of my computer or flash 

drive.  

Another popular way of creating a Desktop shortcut is to 

right click on the file, folder, or program and as you have 

your right mouse button pressed drag the item to the 

desktop and the short cut menu here appears for you to 

choose Create Shortcut here. This is particularly helpful when you 

are viewing the folder or file in File Explorer – right click the file 

and drag it to an empty are of your desktop and you may create the 

shortcut from the menu displayed at right. 

BE CAREFUL! You should pay attention to the menu after you click 

and drag to accidentally move or copy the file to the desktop using 

these methods is very easy to do; therefore, instead of creating a 

shortcut you move or duplicate the file, folder, or program on the Desktop.   

 Hot Tip! Enlarging/Reducing your Desktop items - Zooming. If you have a scrolling 

wheel on your mouse, you may press your CTRL (Control) Key on your keyboard and with 

this (CTRL) key pressed roll your Scrolling wheel up to increase the size or roll the wheel 

down to decrease the size of your desktop icons and shortcuts.  This Zooms and scales 

your Desktop icons and Shortcuts up or down depending on the direction you roll your 

mouse wheel. You may need to select or highlight a desktop item in order for this to 

work. This sizing method works in Microsoft Office and many applications, too, and 

changes your zoom up or down!   
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You can tell that a program, file, or folder is a shortcut by the arrow on 

the icon or by right clicking the icon and activating Properties as I am 

doing with my shortcut to my Windows 8 folder displayed here. The 

Properties dialogue box contains the Shortcut Tab and the General 

Tab displays the file type as a Shortcut (.lnk). If you don’t see the 

Shortcut Tab or the Shortcut (.lnk) BE CAREFUL, your icon on the 

desktop is not a shortcut but the real and actual program, file, or folder.  

Deleting a shortcut from the Desktop is no problem - simply delete the 

item from your shortcut menu or select it and press delete on the 

keyboard; however, deleting the program, file, or folder using these 

methods on the desktop is a problem especially if you ignore your 

warnings and empty the Recycling Bin (OOPS! Your bad.). 

 Practice Makes Perfecdt - Your Turn – Shortcut!  

1. Create your own shortcuts through the right click and drag method 

and the Send to Desktop option using File Explorer.   

2. Next, activate the Shortcut’s property dialogue box and review 

the General and Shortcut tabs. 

 Hot Tip! Power of Properties – The Properties dialogue box 

works on all drives, folders, files, etc. in Windows and offers ways 

to quickly make a file Read-only, Hidden, and you can even 

change the icon using one of the tabs in this great dialogue box. 

Notice that it displays your location, size, and created, modified 

and accessed dates. Here’s my Properties pane for my C Drive 

displayed below. We looked at using the Properties button on our 

Ribbon earlier.   
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Personalization 

Windows 7 and 8 add more punch and power to your ability to customize and enhance your 

desktop and screen savers. As displayed below, when you activate the Personalization pane 

through the Control Panel or by right clicking an empty area of your desktop, themes are 

available for you to use and customize.  I created my own theme as you will learn to 

accomplish here.  You should scroll through the themes and download additional themes from 

the Microsoft website; I have download Australia and then modified it for the Unsaved Theme.  

First, scroll through the various themes and select one that you like. After selecting your 

theme, then you can modify it for a different background, color, sounds, and Screen Saver. 

Your Turn – Choose a Theme 

Using your Personalization Pane review all of the themes and choose several and notice the 

changes that they make.  Take time and use the themes to discover your favorites. 

Important Notes:  

_________________________________________________________________________________

_________________________________________________________________________________ 
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Desktop Background 

After selecting your theme, click the Desktop Background to select a picture or folder to 

display. If you choose a single photo or graphic, the photo or graphic will be your Desktop 

background formerly known as wallpaper.  If you 

select more than one photo or a folder using the 

Browse button or click the photos you want in the 

gallery, the Desktop Background becomes a slide 

show.  With multiple photos selected or an entire 

folder, your timing becomes active. You can set 

the Change picture every – item in various 

increments and shuffle the photos in the folder.  

You should choose how you want the picture to 

display as a Fill, Fit, Stretch, and so on as 

displayed here.  The Desktop Background as a 

Slide Show works the same as using the Screen 

Saver slide show that has been around a few 

years. 

After choosing your Desktop Background, click the 

Save changes button. Your theme becomes an Unsaved and modified theme.  We will save 

your theme after you finish customizing the theme with a different color and screen saver. 

 Hot Tip! Your Start screen can share your 

Desktop background. In the Taskbar and Navigation 

Properties dialogue box and the Navigation Tab we 

learned earlier you may check the Show my 

desktop background on Start and your Start screen 

shares the Desktop background.  

Color Schemes 

Next your color scheme may change, using the 

Personalization pane click the Color Scheme link and 

your pallet opens for you to choose a color scheme.  You 

can alter the transparency and the color intensity using 

the pane. If you really want to customize the color 

scheme you may click on the Show Color Mixer. 
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Sounds 

When you click the Sound link in the main Personalization pane, 

your Sounds Control Panel dialogue box appears.  From here, you 

may choose a different Sound theme and then apply your own sounds 

to certain actions.  I am using the Windows Default sound scheme, 

but I have added sounds for closing programs and other items so the 

word modified appears with my Sound scheme.  I can save this 

Sound Scheme as I have accomplished before with the Greg 1 Sound 

Scheme pictured at right. You should try these different Sound 

Schemes for some interesting (and perhaps annoying effects).  You 

are sure to find one that you like and then you may modify it to 

create your own Sound Scheme. 

Screen Saver 

Once upon a time on a monitor long ago, the system used to “burn” images into our CRT 

monitors if we left a program or pane open for a while without a Screen Saver, so Screen 

Savers were needed. While the need to use a Screen Saver 

has diminished over the years due to advancements in our 

monitor’s technology, we still like to use the Screen Saver 

for fun, protect our computer, and to hide our work when 

we are away from our computer.  Windows  offers some of 

our good old favorite Screen Savers, such as 3D Text and 

Photo Gallery and adds some neat new Screen Savers, like 

Bubbles.  You may download additional Screen Savers, 

BUT be very careful.  Screen Savers are notorious for 

viruses and malicious code (I got the Master Blaster virus 

the day it came out through downloading a Screen Saver 

and no antidote was available – OOPS! My computer, 

Hewbert Packard, never recuperated fully).  If you use the 

Microsoft Online gallery, a virus scan performs for you.  If 

you use another vendor, ALWAYS run an up-to-date virus 

scan before or as you download the screen saver.  Trust 

me, better safe screen saving than being sorry over your 

screen saver. 

The Screen Saver Settings pane allows you to choose a Screen Saver from your list.  After 

selecting your Screen Saver, you may click the Settings. . . button for additional settings, 

such as if you choose the Photos you may select the Pictures folder through the Browse button 

and change the timing of the Screen Saver or Shuffle your photos. Some Screen Savers do 

not have Settings such as Bubbles.  Depending upon the Screen Saver your Settings will 

change and you should set the time when Windows will activate your screen saver. 
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Another important setting is the “On resume, display logon screen” option.  Clicking this to 

activates added protection for your computer by requiring a password when you leave the 

screen saver by touching your keyboard or moving your mouse. I’m sure you or your IT 

associate has already set-up a strong password for your computer.  If not, shame, shame, 

shame. You may change or set-up your Password through User Accounts in the Control 

Panel. 

Other Important Desktop Settings  

There are other Important Settings in the Main Personalization 

Pane in the Navigation area at the Left of your 

Personalization Theme area.  These settings are displayed at 

right for you to change your desktop icons, and mouse 

pointer options. You should use these links to adjust your 

desktop icons. After you click the Change Desktop icons item, 

the Desktop icon tab opens for you to select and change your 

desktop’s icons. I have all of them on my desktop and you can 

change the icon from the default; I have changed Tony’s, my 

Toshiba Laptop, icon. You may select a different icon/picture 

for your desktop item using the Change Icon button and 

associate menu.   

Most importantly are the Mouse pointers, which will activate 

your Mouse Properties dialogue box with several tabs for you 

to review and set your options. The Mouse properties and 

options allow you many selections for how you use your mouse.  I have 

changed my Button settings to allow ClickLock for me to select text and 

other items without holding down my mouse button as I click and drag.  I 

have set my double click speed here, too.  This is where you may change 

your setting from Right handed to Left handed, too. The Pointers and 

Pointer Options tabs allow you to change your pointers, pointer speed, 

and other items.  You should review this based upon the mouse and touch 

pad you are using.   

Your Theme Park! 

Customize your theme with a new desktop background, a modified color scheme, different 

sounds, and set your screen saver.  Review the Mouse Options and set your Desktop icons. 

Create your own theme and save it!  
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Screen Resolution 

Getting to your Screen Resolution in the past was not as easy 

as it is now.  When you right click or tap and hold on an 

empty area of your desktop, you may go directly to your 

Screen resolution from the shortcut menu. While Windows 

does a good job of identifying your monitor and providing the 

optimal screen resolution, you may need to change these 

settings, particularly if you are using a projector with your 

computer.  The projector and/or Windows  may change your 

settings in order to use the projector with your monitor.  I 

have had the projector and Windows change my screen 

resolution settings to fit the needs of the projector, but 

Windows did not return my computer back to the best 

settings, so I have had to use the pane at right to return my 

laptop to the optimal settings.  Also, sometimes the computer and 

Windows  will not recognize a projector that you connect.  The 

Connect to a projector link or work with multiple monitors 

provided or the keyboard short cut using the Windows logo key 

and the P key will help troubleshoot the connection and allows you 

set important display options for your computer and the projector, 

such as Duplicate or Extend (for multiple monitors). Remember the 

higher the resolution the smaller items appear and the smaller the 

resolution the bigger items appear on your screen.  Based on your 

age and eyesight you may need to have a smaller resolution!  
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View by and Sort by 

The final area we want to review in customizing your Desktop is the View by and Sort by 

options when you right click on your Desktop and from the short cut menu activate these 

items. 

View by 

The View by fly out menu allows you to change the 

size of your icons and adjust how they fit on your 

screen.  While I like having my icons snap to a grid 

for orderliness, I like arranging them in any order I 

prefer; therefore, I have the Auto arrange icons 

unchecked and the Align icons to grid checked. 

You may quickly hide your desktop icons from this 

menu, too. 

Sort by 

You may sort your Desktop in a variety of ways, too.  I generally 

keep mine on Name or Item type but you may prefer Date modified 

or size, particularly if you have lots of file, folder, and program 

shortcuts on your Desktop.   

Make your Desktop neat and orderly 

Review your screen resolutions and set your view and sort by items for your desktop. 

Important Notes:  

_________________________________________________________________________________

_________________________________________________________________________________

_________________________________________________________________________________

_________________________________________________________________________________

_________________________________________________________________________________

_______  
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New Stuff ,  Old S tuff ,  and Removed Stuff  

Remember DOS (Dumb Old System – actually Disk Operating System)? I 

sure do – and with the advent of Windows 3.1 I shouted Hallelujah and 

sang the praises of Windows with all of the nice things that came with it 

– Solitaire, Notepad, Sound Recorder, WordPad, Paint, and 

Calculator. Some of the oldies but goodies are gone with Windows 8 – no 

games, not even Solitaire that taught us how to use the mouse in 1991, 

no gadgets as in Windows 7, no 3-D flip. Some oldies are still there on 

your Start screen and the All Apps view in the Windows Accessories 

area I have Notepad, Paint, Snipping Tool, Calculator, and Sticky Notes 

pinned to my Start screen and Taskbar.  Many of your favorites have 

undergone significant changes in the interface and improvements, such 

as Paint and Calculator. Windows Vista contained some nice built in 

features, such as Movie Maker, which is gone and now there are tons of 

apps in the store from which to choose a video editor. You will want to 

go to the App store download the video, audio and photo apps and 

other items.  I found Movie Maker relatively easy to use and loaded with 

features, such as the ability to trim videos, include transitions, and other 

fancy schmancy things without needing a Motion Picture degree from 

UCLA.   

Now, the new stuff we will look at two nice new features in Windows the 

Snipping Tool and Sticky Notes and the enhanced Calculator. 

The Snipping Tool 

There have been (and still are) many third party vendors that have and can provide a way of 

capturing the screen image and parts of an image on your monitor’s display. Most people used 

the good old method of having the image on the screen, pressing the Print Screen (PrtSc) 

key, and then pasting the image into an application, such as a Word 

document or an Outlook email.  Then the user would crop the image, 

resize it, and perform other formatting techniques.  Windows 8 provides 

the Snipping Tool that saves many steps and provides a nice way to 

transfer information displaying on your screen into another application. As 

a technical writer I use the Snipping Tool extensively for the 

screen shots and pictures that you see throughout this manual. 

Since I use this constantly, I pinned this to my Start screen and 

my Taskbar, but you may find the tool in the Start screen and 

All apps view under the Windows Accessories group.  

To use the Snipping Tool display a map, a photo, or other 

object on your screen and click the Snipping Tool item. Using 

the New drop down list in the Snipping Tool menu, you should select the type of snip you 
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want, I usually use Rectangular snip.  You will need a pen mouse or have terrific mouse skills 

to use the Free-form snip, but give it a try, especially on a photo. The 

Window Snip selects a command button, dialogue box or other type of 

pane that you click it, and the Full-screen snip captures your entire 

current monitor display. I use all of these based upon what I need to 

capture for the Snip. For Rectangular and Free-form snips, your screen 

will grey out or dim with a cross hair cursor for a Rectangular Snip or 

scissors for a Free Form Snip you click and drag to select your snip area.  

After you click and drag and release the mouse button the screen 

capture appears in your Snipping tool edit area. I am snipping an area of this document as it 

displays in on my screen. Depending upon the type of 

Snip you may not select the area such as Full Screen 

snips. 

Once your screen shot or snip is in the editing area you 

may save the snip as a .jpg, .gif, or other format using 

the Save button.  The menu bar and toolbar provides 

common actions, such as Copy, Emailing the snip, and 

using the pen to make ink annotations as I have 

accomplished on the awful smiley face. The Pen’s drop 

down item allows you to customize your pen type, the 

color, and thickness of your point.  

You can save your edited snip and reuse the file or close 

without saving. 

 Microsoft’s Office 2010 and 2013 have a great new Screen Shot editing feature that you 

will want to use instead of the Snipping Tool.  

On your own – Snip a map. 

1. Using your web browser display a map. 

2. Activate the Snipping Tool from your Start screen’s Windows Accessories and pin it to 

your taskbar. 

3. At the Snipping Tool menu click the New drop down list and select Free Form or 

Rectangular Snip. 

4. When your screen dims, click and drag your cursor over the area of the map you want 

to use. 

5. After selecting your area, let go the mouse button and your snip appears ready to edit. 

6. Add to your snip by using the pen and customize the pen with a different color and 

point size. 

7. Once you are finished editing your screen shot, save the snip as a .jpg file and email 

the snip to yourself.  
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Sticky Notes (aka 3M® electronic Post-It Notes ®) 

If you have used the popular paper, analog 3M® Post-

It Notes ® then you will like using the digital, 

electronic Windows Sticky Notes, which are very 

similar to using Microsoft’s Outlook’s Notes.  Sticky 

Notes is an app on your Windows Accessories group in the All Apps View.  Unfortunately 

Sticky Notes is not available in all versions of Windows 8; the Windows RT version may not 

have Sticky Notes for your tablet. This app is available and works great if you upgraded from 

Windows 7. 

Once you click the Sticky Notes item, a yellow Sticky Note appears 

ready for you to type your note.  Windows automatically saves your 

notes. You may change the color of your notes by right clicking in 

your writing and editing area.  From the shortcut menu you may 

copy, cut, paste, delete, and select your text as well as change the 

color of the note.  My notes appear at right and the blue note 

displays the shortcut menu. To resize your note you may click the 

lower right corner and drag out to increase the size of the note, in 

fact you may click and drag any note border to resize the note.  The 

plus sign at the top of the note creates an new note and the X at the 

top right corner deletes the note.  You may close the Sticky Notes 

by right clicking the Sticky Notes button on your Taskbar and 

choosing the Close Window Option.  When you activate Sticky Notes again through the Start 

Screen or Taskbar your notes appear for you to edit and create more notes. 

Stick ‘em up – Create your own Sticky Notes 

1. Activate your Sticky Notes from the Start screen and Windows perhaps you should Pin 

this to the Start or Taskbar. 

2. Write yourself a Sticky Note and then right click in the editing/writing area and from 

the shortcut menu change the color. 

3. Using the Short Cut menu, Click Select All and with all of your text selected copy the 

note’s text and paste it in Word, Outlook, or other application. 

4. Close the Sticky Notes by right clicking the Sticky Notes button on the 

Taskbar and clicking Close Window.  

Calculator (On Steroids) 

I was impressed when we could use a standard calculator or a scientific 

calculator in the early days of Windows and at first glance as displayed here 

the Calculator doesn’t appear to have changed much.  But when you click the 

View menu item,  you will notice many options. Now, not only do you have 

Standard and Scientific but also Programmer and Statistics. Wow, I sure hope 

math teachers know that students can use this for homework! I wish I had this 
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in the stone age, actually the slide rule age barely above an abacus 

age! Truly, we’ve come a long way baby. 

The Edit menu item allows you to create a history of your 

calculations, too. 

 

My View menu item for the Calculator appears at right with the 

Worksheets selected and Mortgage.  You can calculate Fuel 

Economy and Vehicle leases, too. I am calculating a automobile 

loan for $18,500 purchase price with a $2000 down 

payment for four years at a 4% APR.  When I click 

the Calculate button, the result appears as 

displayed below.  To return to a “regular” calculator 

select Basic from the View Menu.   

Calculate This! Up to you – 

1. Activate the Calculator under the Start 

Screen’s Windows Accessories. 

2. Using the calculator’s Mortgage Worksheet 

under the View menu, calculate your 

mortgage payment or other loan with a 

constant interest rate and terms.   

3. Return the calculator to basic or other view and practice calculating the hypotenuse of 

a triangle with the cosign and tangents and then a square root of the standard 

deviation of your weight! 
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